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Section 1: Overview of SQL and Oracle Database Configuration

 Overview of Database Configuration

Special Instructions for Configuring Databases 

For your convenience this document pulls the information on database configuration out of the hp OpenView 
Reporter Installation and Special Configuration Guide and includes it with your Internet Services product.

Overview

Internet Services and Reporter share the same database for storing performance and reporting information. 

The default database for Internet Services 3.5 was MS Access.   The default database for Internet Services now 
is Microsoft SQL Server 2000 Desktop Engine SP3 (MSDE with Service Pack 3).  

 IMPORTANT: When upgrading from a previous version of OVIS or Reporter the minimum requirement for 
SQL Server 2000/MSDE is now Service Pack 3.  This Service Pack is required to deal with vulnerability in SQL 
Server 2000 to destructive computer viruses (such as the SLAMMER worm virus). Please upgrade your 
database instance before installing OVIS 4.5.  Refer to the OVIS release notes for more detailed instructions on 
upgrading to this Service Pack. 

You may choose to change the database to one of the following supported databases:

●     Oracle 8.1.7 for Solaris or HP-UX
●     Oracle 9i for Solaris or HP-UX
●     SQL Server 2000 Service Pack 3

Note that Oracle 8.0.6 and SQL Server 7 are only supported on an upgrade from an earlier version of OVIS 
where you were using these database versions.  

WARNING: Migration of data from a different database to the new SQL Server or Oracle database is not 
supported for Internet Services.  And if you have OVIS and Reporter on the same system, attempting to migrate 
Reporter data to the new database may result in problems in OVIS.

There are several database configurations possible depending on which OpenView products you have installed. 
See the following scenarios:
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Section 1: Overview of SQL and Oracle Database Configuration

If you have Reporter already installed on the same 
system as Internet Services is or will be installed.

When you install OVIS, it will detect whatever 
database is configured for Reporter and use this 
same database. The OVIS installation configures a 
connection to this database and adds table entries 
for OVIS as needed.

If you do not have Reporter and are installing 
Internet Services for the first time.

The MSDE default database is installed. You can 
later use instructions in this guide for configuring 
an Oracle or SQL Server 2000 database instead.

If you do not have Reporter and are updating from 
a previous version of Internet Services to version 
4.5 

The upgrade to OVIS 4.5 uses the existing 
database, it could be MS Access, Oracle 8.0.6 or 
8.1.6/7 or SQL Server 7 or 2000.

If you do not have Reporter or OVIS on the 
system, and for some reason you have SQL 7 
installed on the system but not configured for use 
with OVIS or Reporter and install OVIS

The install will install MS Access as the default 
database instead of MSDE.  This is because SQL 7 
and MSDE are not compatible.

Using this guide

The information in this guide was taken from the Reporter documentation. The database configuration 
procedures are almost identical for Internet Services but since the document was created for Reporter you will 
need to consider the following:

References to the Reporter product in this document apply to Internet Services also.

References to using the Reporter GUI to configure Oracle database logins are replaced with instructions for 
using the Internet Services Configuration Manager to configure the Oracle database logins.
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Section 2: UNIX Settings

 UNIX Settings

This document shows settings (Part I) for the default installation, where you use the Oracle database, and 
settings for a custom database configuration (Part 2). The topics are as follows: 

■     Part 1: Setting Kernel Parameter Minimum Values
■     Part 2: For Oracle Database Setup on UNIX / Setting UNIX Environment Variables 

Part 1: Setting Kernel Parameter Minimum Values 

Kernel parameters setting for HP-UX and Solaris systems are outlined below. 

HP-UX Systems 

For your system to run more efficiently, modify (as necessary) the HP-UX kernel parameters to meet or exceed 
the minimum values listed below. To modify kernel  values, run SAM and use the Kernel Parameters area to 
change the specific parameters within the Action menu.

maxdsiz 32 MB
maxfiles 120
maxssiz 2 MB
maxuprc 256
nfile 3000
nproc 700
semmni 20
semmns 128
shmmax 64 MB
shmmni 100
shmseg 12

 IMPORTANT! To activate changes to settings, you must reboot your system.

 

Solaris Systems 

For your system to run more efficiently, modify (as necessary) the Solaris shared memory parameters to meet or 
exceed the minimum values listed below. To modify shared memory values, edit the /etc/system file and change 
the specific parameters as listed below:
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Section 2: UNIX Settings

set shmsys:shminfo_shmmax=67108864
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmmni=100
set shmsys:shminfo_shmseg=40
set semsys:seminfo_semmns=200
set semsys:seminfo_semmni=100
set semsys:seminfo_semmsl=30

 IMPORTANT! To activate changes to settings, you must reboot your system.

 

Part 2: For Oracle Database Setup on UNIX / Setting UNIX 
Environment Variables 

New Oracle Installations

1.  You must be logged on as root or su
2.  Set UNIX environment variables as follows:

ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_SID - set to the database name you want to create (reporter) 
ORACLE_HOME - set to full pathname of the Oracle system home directory
$ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin
UMASK = 022

Existing Oracle Installations

Verify that the following HP-UX environment variables are set:

ORACLE_BASE – set to admin pathname default (/opt/oracle)
ORACLE_SID - set to the database name you want to create (reporter) 
ORACLE_HOME - set to full pathname of the Oracle system home directory 
ORACLE_TERM – set to the appropriate value (hpterm, etc…)
PATH - needs to include $ORACLE_HOME/bin
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Section 3: Configure SQL Server as the Database

 Set Up Microsoft SQL Server as the Database

 
Internet Services now uses MSDE SP 3 (Microsoft SQL Server Desktop Engine) as the default 
database. (Previous versions of Internet Services used MS Access as the default database.) 
The MSDE version that is used is a subset of SQL Server 2000, which means that much of the 
SQL 2000 functionality is present in the MSDE database, even though no dialogs are available 
to assist in the configuration. MSDE has a 2GB size limit per database instance. Knowing this, 
you may at some point choose to upgrade to a SQL Server 2000 database. When upgrading 
from MSDE to SQL Server 2000 follow the instructions provided by Microsoft and choose the 
OVOPS instance to upgrade.  

The instructions for changing to a new SQL Server 2000 database (rather than upgrading from 
MSDE) are contained in the Part B link below.  These instructions could be used when 
changing from Microsoft Access to SQL Server 2000 or when installing SQL Server 2000 on a 
remote system.  

For this version of MSDE you will not be able to use the SQL Server 7.0 Enterprise Manager  to 
look at the data in the MSDE database. The Internet Services data gets stored in an instance of 
MSDE. The use of named instances is new for SQL Server 2000 and only a single default 
instance is supported by SQL Server 7.0. To use the SQL Server 7.0 Enterprise Manager, you 
would need to use an existing SQL 7.0 database.

 IMPORTANT: Do not run multiple copies of Internet Services as unexpected results occur 
when more than one attempts to write data to the configured database. 

 IMPORTANT: Migration of data from your old database to the new SQL Server database is 
not supported for Internet Services (OVIS).  And if OVIS is on the same system as hp 
OpenView Reporter, attempting to migrate Reporter data to the new database may result in 
problems in OVIS.

 IMPORTANT: When upgrading from a previous version of OVIS or Reporter the minimum 
requirement for SQL Server 2000/MSDE is now Service Pack 3.  This Service Pack is required 
to deal with vulnerability in SQL Server 2000 to destructive computer viruses (such as the 
SLAMMER worm virus). Please upgrade your database instance before installing OVIS 4.5.  
Refer to the OVIS release notes for more detailed instructions on upgrading to Service Pack 3.

■     Part B: Configure Microsoft SQL Server 2000 as the Reporter database.
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Section 3, Part B: Configure SQL Server 2000 

 Set Up Microsoft SQL as the Database
Part B: Configure SQL Server 2000 

Set Up SQL Server 2000 as the Database

To use Microsoft SQL Server as the  Internet Services database requires both server and client software. The first 
section of this procedure covers the SQL server software installation and configuration. The second section covers 
the SQL client  software installation as well as Internet Services configuration as an SQL Server account. 

Internet Services 4.5 uses the MSDE SP3 (Microsoft SQL Server Desktop Engine) as its default database. The 
MSDE version that is used is a subset of SQL Server 2000, which means that much of the SQL 2000 functionality 
is present in the MSDE database, even though no dialogs are available to assist in the configuration. MSDE has a 
2GB size limit per database instance. Knowing this, you may at some point choose to change to an SQL Server 
2000 database. When upgrading from MSDE to SQL Server 2000 follow the instructions provided by Microsoft and 
choose the OVOPS instance to upgrade. 

The instructions for changing to a new SQL Server 2000 database (rather than upgrading from MSDE) are 
contained in the Part B link below.  These instructions could be used when changing from Microsoft Access to SQL 
Server 2000 or when installing SQL Server 2000 on a remote system.  

Since the Internet Services product does use an MSDE instance name (OVOPS) you will see the instance name 
when using SQL Server 2000 Enterprise Manager to look at the Reporter database. The corresponding SQL 
Server 2000 examples will not use the instance name. You are not required to use an instance name when using 
SQL Server 2000. 

 IMPORTANT: When upgrading from a previous version of OVIS or Reporter the minimum requirement for SQL 
Server 2000/MSDE is now Service Pack 3.  This Service Pack is required to deal with vulnerability in SQL Server 
2000 to destructive computer viruses (such as the SLAMMER worm virus). Please upgrade your database 
instance before installing OVIS 4.5.  Refer to the OVIS release notes for more detailed instructions on upgrading to 
Service Pack 3.

 IMPORTANT: Migration of data from your old database to the new SQL Server database is not supported for 
Internet Services (OVIS).  And if OVIS is on the same system as hp OpenView Reporter, attempting to migrate 
Reporter data to the new database may result in problems in OVIS.

The following is an overview of the configuration steps:

Configure the SQL Server system.
Task 1. Install SQL Server software.
Task 2. Verify the trust relationship between client and server.
Task 3. Configure the database on SQL Server.
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Section 3, Part B: Configure SQL Server 2000 

Configure the SQL Client system.
Task 1. Install Internet Services.
Task 2. Install SQL Client software.
Task 3. Establish the ODBC connection.
Task 4. Configure Internet Services to use SQL as the database.
Final Task. Confirm that the database was set up. 

Install & Configure SQL Server Software on Windows Server

If you have already installed SQL Server, you can skip Task #1. If your Internet Services system and the SQL 
Server system are in the same domain, you can skip task Task #2 and go directly to Task #3. 

Prerequisites include:  Windows NT 4.0, Service Pack 6A (or higher) or Windows 2000 Service Pack 2 or 3, and  
Internet Explorer 5.01, Service Pack 2 or higher. 

 IMPORTANT: Service Pack 3 is required with SQL Server 2000.

Task 1  Install SQL 2000 Server Software

1.  Insert the SQL Server  2000 CD into the CD-ROM drive. 
2.  Select Install SQL  2000 Components. 
3.  Select Database Server – Standard Edition. 
4.  Select Local Computer and respond to prompts as they appear. 
5.  Be sure to use Mixed Mode for authentication.
6.  Restart the system.
7.  Upgrade to SQL Server 2000 Service Pack 3.
8.  Restart the system.

Task 2  Verify Trust Relationship Between Client and Server 

Note: A trust relationship should be set up if the Internet Services client and SQL Server are in separate 
domains in NT4 or if the client and server run on mixed systems (Windows NT4 or Windows NT4 and Windows 
2000). If the client and SQL Server are running on Windows 2000, skip this task. 

1.  Log on to the SQL Server-installed system with Administrator privileges.  
2.  From the Start menu select Programs>Administrative Tools>User Manager for Domains. 
3.  From the Policies menu select Trust Relationships. 
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Section 3, Part B: Configure SQL Server 2000 

4.  In the Trusting Domains dialog box, look for the Domain where Internet Services is located. If the 
appropriate domain is displayed, continue to the next task.
If not, add the trusting domains as needed. If you have questions about trusting domains, click the Help 
button (if Internet Services and SQL Server systems are in separate domains, you must configure a trust 
relationship between the systems). 

Task 3  Configure the Database on SQL Server  2000

1.  From the Start menu select Programs>Microsoft SQL Server  2000 >Enterprise Manager.
2.  In the Microsoft Console Root window, select your SQL Server Group. 
3.  If your SQL Server system is not listed under the SQL Server Group, right-click SQL Server Group, select 

New SQL Server Registration from the drop-down menu and follow the wizard online steps to register.  
4.  Right-click Databases – New Database  
5.  In the General tab for the Name box, enter a name for the database (example uses  Reporter as the 

name).
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Section 3, Part B: Configure SQL Server 2000 

 Note: The SQL Server database no longer needs to be named Reporter.

6.  Select the Data Files tab and in the Database files segment, in the Initial size (MB) column, enter 100.
7.  Click OK to close the window. 
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Section 3, Part B: Configure SQL Server 2000 

  

8.  After the database is created, expand Security.
9.  Right-click Logins – New Login... 

10.  Select General Tab and in the Name box enter the user name openview or your specified user. 
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Section 3, Part B: Configure SQL Server 2000 

  

11.  Under Authentication select the SQL Server authentication radio button and enter your password. 
12.  Under the Defaults, select Reporter from the Database list box. 
13.  Select the Database Access tab and under Database access check the Permit box that corresponds to 

Reporter. 
14.  Under Database roles for Reporter, check public and db_owner and select OK to exit. 
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Section 3, Part B: Configure SQL Server 2000 

15.  Confirm the new password from Step 11. 

To verify User has Database Access, in the left pane expand the security folder, or click the plus sign next to each 
item: Security>Logins and you should see openview in the right pane.
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Section 3, Part B: Configure SQL Server 2000 

 

 

17.  Exit Enterprise Manager and go to the client system (where Internet Services is installed).

Install & Configure SQL Client Software 

Installing SQL 2000 Client includes three general areas: 

■     Upgrade newer versions of Internet Services or the SQL database, or install Internet Services if not already 
installed

■     Configure Reporter ODBC connection 
■     Install SQL 2000 software 

SQL 2000 Client Installation Prerequisites 

■     Internet Explorer 5.01 SP 2 
■     500 MB Free Disk Space 
■     SQL Server 2000 CD 
■     Product License – 10 digit code 

Task 1  Upgrade or Install Internet Services            
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Section 3, Part B: Configure SQL Server 2000 

1.  Install or upgrade Internet Services as needed. 

Task 2  Install SQL Client Software 

Important: This task is unnecessary if  Internet Services and SQL Server are installed on the same system. 

1.  Insert the SQL Server  2000 CD to install the SQL Client 2000 software. 
2.  Click autorun.exe. 
3.  Click Install SQL  2000 Components. 
4.  Select Install Database Server 
5.  Follow the instructions as they appear. 
6.  (NT4) Select Management Tools and Client Connectivity as the components to install; you can choose 

whether or not to install documentation. 
(Windows 2000) Select Server Components, Management Tools, and Client Connectivity as the 
components to install, you can choose whether or not to install documentation.
 

7.  Reboot the system after installation is complete 

Task 3  Establish the ODBC Connection 

Important Note: Be sure that Internet Services is installed before beginning this step.  Also be sure that 
the  Configuration Manager is closed before beginning this step.

1.  Stop the following services:
HP Internet Services
Reporter Service
World Wide Web Pubshishing Service

2.  On Windows NT 4.0: From the Start menu select Settings>Control Panel and double-click ODBC.
On Windows 2000: From the Start menu select Settings>Control Panel and doubel-click Administrative 
Tools.  Then double-click Data Sources (ODBC).

3.  In the ODBC Data Source Administrator window select the System DSN tab. Highlight Reporter and select 
the Remove button.
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Section 3, Part B: Configure SQL Server 2000 

4.  Select the Add... button to create a new Reporter data source. 
5.  In the Create New Data Source dialog box select the SQL Server driver and the Finish button.
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Section 3, Part B: Configure SQL Server 2000 

6.  In the Create a New Data Source to SQL Server dialog, make sure that Reporter appears in the data 
source name box and the server name appears in the Server box. Then select Next. 
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Section 3, Part B: Configure SQL Server 2000 

7.  Select - With SQL Server authentication using a login ID and password entered by user. 
Also check the box for Connect to SQL Server to obtain default settings.  
Enter the login ID and password that you used in the first section Install & Configure SQL Server 
2000: Task 3  - Configure the Database on SQL Server  2000.  Then select Next.
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Section 3, Part B: Configure SQL Server 2000 

8.  Check Change the default database to, select Reporter, and click Next.

9.  Check Perform translation for character data and select Finish. 
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Section 3, Part B: Configure SQL Server 2000 

10.  In the ODBC Microsoft SQL Server Setup dialog select the Test Data Source... button.
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Section 3, Part B: Configure SQL Server 2000 

  

11.  Exit the SQL Server ODBC Data Source Test by clicking OK. 
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Section 3, Part B: Configure SQL Server 2000 

Task 4  Configure Internet Services to use SQL as the Database 

1.  To start OpenView Internet Services Configuration Manager, select 
Start>Programs>HP OpenView>internet services>Configuration Manager.

2.  If you see an error message; click Yes or OK to proceed.  Then database login may be required, if so see 
the next step, proceed to step 5. 

3.  In the Database Login dialog box, enter the database User ID and Password that you used for the system 
configuration.
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Section 3, Part B: Configure SQL Server 2000 

4.  Click OK. 
5.  You will see the  Internet Services Startup status bars . Then the Configure License dialog

may be displayed.  Follow the instructions for licensing or click OK to continue. Then the 
main Configuration Manager window displays.

6.  Start the following services: 
HP Internet Services
Reporter Service
World Wide Web Publishing Service

Final Task Confirm that the Database is Set Up 

1.  From the Start menu, select Programs>Microsoft SQL  2000>Query Analyzer.
2.  Connect to your SQL Server using SQL Server authentication using the user name and password you 

created.
3.  In the SQL Server Query Analyzer dialog, select DB: reporter. 
4.  Enter a query to verify the database connection.
5.  Then you can check the setup of the  Internet Services probes by entering the query:

select PROBENAME from IOPS_PROBE_DEFINITIONS
6.  Click the green arrow or press F5.
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Section 3, Part B: Configure SQL Server 2000 

7.  The following is an example of the results.
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Section 3, Part B: Configure SQL Server 2000 
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Section 4: Configure Oracle as the Database

  Setup Oracle as the Database

Internet Services can be configured to work with Oracle as its database. The topics below cover 
serveral versions of Oracle. 

 IMPORTANT: Note that screen examples and steps may be different than documented in 
the following sections if your operating system or version is different than the one used in the 
example.

 IMPORTANT: An Oracle DBA should be involved in creating the database, particularly for 
configuration issues like database sizing and AUTOEXTEND of datafiles. 

 IMPORTANT: Do not run multiple copies of Internet Services as unexpected results occur 
when more than one copy of Reporter attempts to write data to the configured  database. 

 IMPORTANT: Migration of data from a different database to a new Oracle database is not 
supported for Internet Services (OVIS). And if OVIS is on the same system as hp OpenView 
Reporter, attempting to migrate data to the new database with Reporter may result in problems 
in OVIS. 

■     Part G: Configure Oracle  8.1.7 (HP-UX or Solaris) as the database
■     Part H: Configure Oracle 9i (HP-UX or Solaris) as the database
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Part G: Configure Oracle 8.1.7 (HP-UX or Solaris) as the Database

 Setup Oracle as the Database
Part G: Configure Oracle 8.1.7 as the Database 

Set Up Oracle 8.1.7 on HP-UX or Solaris and Configure on Windows 

Prerequisites: Check your HP-UX or Solaris system kernel parameters and modify as necessary. Internet Services requires 
1GB disk space in the Oracle database initially if you use the repconfig.sql script provided by OVIS. 

For other system, memory, and disk requirements, please check the "System Requirements" section of the Oracle 8i 
Installation Guide included with the software distribution. Oracle has specific recommendations regarding optimal database 
installation and architecture. This document does not discuss all aspects of database installation and administration. We 
suggest that you consult Oracle technical literature and qualified Oracle professionals to achieve optimum database 
performance in your particular environment. 

 IMPORTANT: Migration of data from a different database to the new Oracle database is not supported for Internet Services 
(OVIS). And if OVIS is on the same system as hp OpenView Reporter, attempting to migrate data to the new database with 
Reporter may result in problems in OVIS.

On the UNIX or Solaris system (choose the appropriate procedure by clicking it): 

●     Setup for new installations of Oracle 8.1.7 
     (Task 1 — 6) 

●     Setup for existing installations of Oracle 8.1.7 
    (Task 4 — 6) 

On the Windows system running Internet Services: 

●     Configure Internet Services to use the Oracle database 

Case Sensitivity: Some required entries in Windows are case-sensitive; so we recommend you match instruction text 
exactly. 

Setup for new installations of Oracle 8.1.7 

Task 1 Create Oracle groups, user, and home directory
Task 2 Mount the CD 
Task 3 Install Oracle software using the Oracle Universal Installer
Task 4 Create Reporter database objects
Task 5 Create Reporter Tablespace, User, and Privileges 
Task 6 (optional) Configure Automatic Database Startup and Shutdown 

Task 1  Create Oracle groups, user, and home directory 
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Part G: Configure Oracle 8.1.7 (HP-UX or Solaris) as the Database

Before you begin, you need the following administrator privileges: root and dba privileges on the UNIX system where you are 
using Oracle; administrator privileges on the Windows client where Internet Services is installed. 

1.  You must be logged on as root or su.
2.  For HP-UX: Use System Administration Manager (SAM) utility on HP-UX 11.0 to create UNIX group dba. 

For Solaris: Use admintool or (groupadd utility) to create UNIX group dba.
3.  For HP-UX: Use SAM utility to create UNIX group oinstall.

For Solaris: Use admintool or (groupadd utility) to create UNIX group oinstall.
4.  For HP-UX: Use SAM utility to create UNIX user oracle.

For Solaris: Use admintool (or useradd utility) to create UNIX user oracle.

a. Login name: oracle
b. Primary Group Name: oinstall
    Secondary Group Name: dba 
c. Home directory: consistent with local standards
d. Login shell: consistent with local standards 

5.  Create Oracle Home mount point: mkdir –p /opt/oracle/product/8.1.7
6.  Enter: cd /opt 
7.  Enter chown –R oracle:oinstall oracle 

 

Task 2  Mount the CD 

For HP-UX:

1.  Edit the /etc/pfs_fstab file (create it if it does not exist) to add the following line:
Syntax:
<device_file> <mount_point> <filesystem_type> <translation_method>
Definitions of the syntax above:
<device_file> = CD-ROM device file (discover with ioscan –nFC disk)
<mount_point> = path name of the mount point 
<filesystem_type> = CD-ROM is in IS09660 format, Rockridge extension <translation_method> = unix
For example:
/dev/dsk/c1t2d0 /CDROM pfs-rrip xlat=unix 0 0 

2.  Perform the following steps as the root user:
Enter: /usr/sbin/pfs_mountd &  (Note:pfs creates the correct format to read the CD)
Enter: /usr/sbin/pfsd & 

3.  Insert the CD into the CD-ROM and mount the device as follows:
/usr/sbin/pfs_mount /CDROM 

4.  Leave the root user window available for executing a script during installation .

For Solaris:

If you are using Volume Management software (available by default on Solaris) the CD-ROM is mounted automatically to 
/cdrom/oracle8i when you put it into the disk drive.

If you are not using the Volume Management software, you must mount the CD-ROM manually.
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1.  Place the Oracle 8i CD-ROM in the CD-ROM drive.
2.  Log in as the root or su user and create a CD-ROM mount point directory:

$ su root
# mkdir cdrom_mount_point_directory

3.  Mount the CD-ROM drive on the mount point directory and exit:
# mount option device_name cdrom_mount_point_directory
# exit

Task 3  Install Oracle software using the Universal Oracle Installer 

1.  Log in to the oracle account
a. Verify umask command returns 022
b. Set umask 022 in .profile if needed

2.  Set UNIX environment variables as follows: (add to .profile,or set manually)
DISPLAY=<workstation_name>:0.0 (<workstation_name> is computer where output from the Oracle Universal 
Installer should be displayed)
ORACLE_BASE=/opt/oracle
ORACLE_HOME=/opt/oracle/product/8.1.7
ORACLE_SID=REPORTER
PATH includes $ORACLE_HOME/bin, /usr/bin, /etc, /usr/ccs/bin, /usr/local/bin

3.  Start the Installer: /CDROM/runInstaller

 Important: These procedures and screen examples are for Oracle 8.1.7 on HP-UX.  Other operating systems and 
versions may be different.

In the Welcome dialog, click Next.
4.  In File Locations do not change the product Source...Path entry., 

The Oracle Home Destination...Path entry should display the value for ORACLE_HOME if previously set; click Next. 
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5.  For the UNIX Group Name enter oinstall and click Next. 
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6.  If /var/opt/oracle does not exist or can not be edited by the oracle user, you are prompted to run 
/tmp/Orainstall/orainstRoot.sh. 
After running this script, click Retry to continue. 

7.  Under Available Products select Oracle8i Enterprise Edition 8.1.7.0.0, click Next. 
8.  Under the Installation Types select Minimal installation; click Next.   
9.  In the Privileged Operating System Groups enter dba for the UNIX groups and click Next.  

10.  In Select Starter Database select No, and click Next.   
11.  In the Summary verify Space Requirements and select the Install button. 

The Install dialog appears.  
12.  In the Setup Privileges dialog run root.sh as instructed.  
13.    When the "Install successful" message appears, click Next.

The Configuration Tools dialog appears.  
14.  In the Net8 Configuration Assistant Welcome window click Next.
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15.  Select No to defer directory naming; click Next.   
16.  Select a Listener name—LISTENER is recommended—and click Next.   
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17.  Select TCP for the connection protocol, click Next.   
18.  Select the standard port number of 1521, click Next.   
19.  Select No for configuring another listener, click Next.   
20.  At "Listener configuration complete" message, click Next.  
21.  Select No for changing the naming methods, click Next.   
22.  At the "Net8 Configuration Complete" message, click Finish. 
23.  In the End of Installation dialog click Exit. 

Task 4  Create Reporter database objects 

1.  Log in to the oracle account 
2.  Update UNIX environment variables as follows: (add to .profile,or set manually)

DISPLAY=<workstation_name>:0.0 
(<workstation_name> is computer where output from the Oracle products should be displayed)
ORACLE_BASE=/opt/oracle 
ORACLE_HOME=/opt/oracle/product/8.1.7
ORACLE_SID=REPORTER
PATH includes $ORACLE_HOME/bin, /usr/bin, /etc, /usr/ccs/bin, /usr/local/bin

for HP-UX: SHLIB_PATH=$ORACLE_HOME/lib
for Solaris: LD_LIBRARY_PATH=$ORACLE_HOME/lib

for Oracle 8.1.7:
CLASSPATH=$ORACLE_HOME/JRE/lib:$ORACLE_HOME/jlib:
$ORACLE_HOME/network/jlib:$ORACLE_HOME/rdbms/jlib:$ORACLE_HOME/assistants/jlib
TNS_ADMIN=$ORACLE_HOME/network/admin 

3.  Run the Database Configuration Assistant by entering dbassist 
4.  In the startup window select Create a database, click Next.  
5.  Select Custom as the database type, click Next.
6.  Select Multipurpose as the type of application, click Next. 
7.  Select number of concurrently connected users (suggest 40), click Next. 
8.  Select Dedicated Server Mode, click Next. 
9.  No options required for Reporter database; click Next. 
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10.  Enter the Global Database Name (i.e. reporter<.domain.name> ) and SID (REPORTER). Note that REPORTER must 
be entered all uppercase. Then click Next. 

11.  Review the Control File information, click Next. 
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Note: Oracle recommends multiplexing controls files on different disks to support database recoverability.
12.  Accept the defaults for all the tabs (click Next through the tabs) unless otherwise recommended by your Oracle 

Administrator.    

13.  Review the Redo Log Files information; click Next.  

file:///C|/FrontPage%20Webs/Content/hpovreports/Help/Concepts_Guide/section04G.htm (9 of 16) [2/10/2003 5:40:57 PM]



Part G: Configure Oracle 8.1.7 (HP-UX or Solaris) as the Database

14.  Review the logging parameter information; click Next. 
15.  Review the SGA parameter information; click Next. 
16.  Review the Trace File Directory information; click Next.  
17.  Select Create database now; click Finish. 

Task 5  Create Reporter tablespace, user, and privileges*

1.  Log on as root or su. 
2.  Create the file (below) and save as repconfig.sql in the $ORACLE_BASE/admin/reporter/create/ directory: 

Note: You must replace /database/oradata with the path you have established for your database data files. The 
data file names are only recommendations and can be changed to conform to the standards at your site. Also the user 
and password are highlighted; change as necessary.

Note: For performance considerations Oracle recommends to place data (tablespace REPORTER), index 
(tablespace RPT_INDEXES), and rollback segments (tablespace RBS) on different disks if available.

 Important: If the actual storage size of 600MB for REPORTER tablespace and 300MB for the RPT_INDEXES 
tablespace is not large enough, please consult your Oracle DBA on the appropriate size for your environment or how to 
setup the AUTOEXTEND datafile feature in Oracle. 

create tablespace REPORTER datafile
'/database/oradata/reporter/rptdb01.dbf' SIZE 600M
extent management local autoallocate;
);
create tablespace RPT_INDEXES datafile
'/database/oradata/reporter/rptidx01.dbf' size 300M
extent management local autoallocate;
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);
create user openview identified by openview 
default tablespace REPORTER;
grant create session, create table, create any index, create sequence, create trigger, unlimited tablespace to openview;

3.  Log on as the oracle software owner. 
4.  Make sure the ORACLE_SID is set to REPORTER; otherwise the Internet Services tables will be put in the wrong SID. 
5.  Run the $ORACLE_HOME/bin/svrmgrl program and enter the following commands to start the database (the 

database may have already been started)
connect internal
startup 

6.  Enter the following SQL statement: 
@$ORACLE_BASE/admin/reporter/create/repconfig.sql 

7.  Enter the following command to exit: Exit 
8.  Enter the following commands to restart the SQL listener: 

lsnrctl stop
lsnrctl start 

Task 6 Configure Automatic Database Startup and Shutdown

You may optionally configure the database for automatic startup and shutdown. See the Oracle documentation for details on 
this procedure.

 Warning! If your database administrator already has the startup procedure in place, you should skip this 
step. 

 Warning! If the OVO (also known as VantagePoint Operations or ITO) (openview) database is installed on 
same Oracle server, you must modify its oratab entry to change the startup flag from "Y" to "N" since it is 
restarted by a different facility. For example, change openview:$ORACLE_HOME:Y to 
openview:$ORACLE_HOME:N. 

Now you are ready to configure Internet Services to use the Oracle database.

Configure Internet Services on the Windows System 

This section covers the installation of the software that allows the Windows system, on which Internet Services runs, to connect 
to the HP-UX or Solaris system, from which the Oracle database is accessed. 

Task 1  Install Oracle Client software 

To begin, you need the following Oracle product: Oracle8i Client (8.1.7) for Windows (NT 4 or 2000). You also need 
administrator privileges on the Windows client where Internet Services is installed 

1.  At your Windows system, insert the Oracle8i Client CD and select Install/Deinstall Products in the dialog box that 
appears.  

2.  In the Oracle Universal Installer Welcome dialog click Next. 
3.  In the File Locations dialog enter the Source and Destination file locations and click Next. 
4.  In the Installation Types dialog select Administrator as the installation type and click Next. 
5.  Verify information in the Summary dialog and click Install. 

The installation process starts the Configuration Tools dialog. The Net8 Configuration Assistant will optionally be run. 

Task 2 Configure the Net8 connection to the Reporter database 

file:///C|/FrontPage%20Webs/Content/hpovreports/Help/Concepts_Guide/section04G.htm (11 of 16) [2/10/2003 5:40:57 PM]



Part G: Configure Oracle 8.1.7 (HP-UX or Solaris) as the Database

After you complete the installation of the Oracle client software (the Net8 Configuration is optionally part of the client install and 
dialog steps may differ slightly) on the Windows system running Internet Services, on that same system complete the following 
steps: 

1.  From the Start/Programs menu, select Oracle><Oracle_Home>:Network Administration:Net8 Configuration 
Assistant.

2.  In the Welcome dialog select Local Net Service Name configuration and click Next. 
3.  Select the Add radio button; click Next. 
4.  In the Database Version dialog, select Oracle8i database or service (select the other option if connecting to a previous 

Oracle version), click Next.  
5.  In the Service Name dialog supply the global database name you entered in Task 4, step #10, of Configure Reporter 

database on UNIX; (i.e. reporter.<domain.name>); click Next.   
6.  At the Select Protocols dialog, select TCP, click Next. 
7.  At the TCP/IP Protocol dialog, supply the Host Name and port number (typically 1521), click Next.  

8.  At the Test dialog, select Yes, perform a test; click Next.   
9.  At the Connecting dialog, verify that the connection was successful (you may have to change the login credentials (i.e., 

openview/openview) for the test to succeed); click Next. 
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10.  At the Net Service Name dialog, supply a Net Service Name (suggested: RPT), and click Next.

11.  In the Another Net Service Name? dialog, select No, and click Next. 
12.  In the Done dialog, click Next, and then Finish. 
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Note: The Net Service Name (i.e., RPT) may have the network domain appended to its name, for example 
RPT.<DOMAIN.NAME>. Rerun the Net8 assistant and select test to verify the actual, full Net Service Name.

Task 3 Verify the Net8 connection to the REPORTER database

After you complete the Net8 configuration, perform the following steps to verify that you can contact the database from your 
Windows system: 

1.  From the Start/Programs menu, select Oracle <Oracle_Home>, Database Administration, and SQLPlus Worksheet. 
2.  In the Oracle Enterprise Manager Login dialog, enter the database Username and Password that you used for the UNIX 

system configuration in Task 5, step 2 (username: openview, password:openview). Enter the Service name 
(RPT.<domain_name>)

3.  Click the OK button. 
4.  In the SQL*Plus Worksheet, enter the command:

select TABLESPACE_NAME, STATUS from user_tablespaces

The following tablespace names should be displayed:
TABLESPACE_NAME                 STATUS
--------------------------------------
SYSTEM                          ONLINE
TOOLS                           ONLINE
RBS                             ONLINE
TEMP                            ONLINE
USERS                           ONLINE
INDX                            ONLINE
REPORTER                        ONLINE
RPT_INDEXES                     ONLINE
8 rows selected.

If you cannot connect to the database, or do not see these tables, check with the Oracle database administrator 
for the UNIX host system. 

5.  From the File menu select Exit. 
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Task 4 Configure the ODBC data source in the Windows Control Panel

After you have configured Net8 on the Windows system running Internet Services, you must configure the ODBC data source. 

On the Windows system where Internet Services is (or will be) installed, complete the following steps: 

1.  Stop the following services:
HP Internet Services
Reporter Service
World Wide Web Pubshishing Service

2.  Select Start>Settings>Control Panel. 
3.  In the Control Panel window::

for Windows 2000 double-click Administrative Tools (Windows 2000), then
ODBC Data Sources.
for NT 4 double-click ODBC Data Sources. 

4.  Select the System DSN tabbed page. 
5.  Choose Reporter with the default database driver and remove it. 
6.  Select the Add… button and highlight Oracle ODBC Driver and select Finish. 
7.  In the dialog box that appears, enter the following:

Data Source Name: Reporter  
Description: <your_description> 
Service Name:  RPT.<domain_name>
User ID:  (no entry necessary)

 Important: You must enter Reporter as the Data Source Name in mixed case (uppercase "R") to match references 
to it in Internet Services executables. 

Task 5 Configure Internet Services to use the Database
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1.  To start  Internet Services Configuration Manager, select 
Start>Programs>HP OpenView>internet services>Configuration Manager.

2.  An error message is expected; click Yes or OK to proceed.  Then database login may be required, if so see the next 
step, proceed to step 5. 

3.  In the Database Login dialog box, enter the database User Name and Password that you used for the UNIX system 
configuration in Task 4, step 4 (username: openview; password: openview).

 
4.  Click OK 
5.  You will see the  Internet Services Startup status bars . Then the Configure License dialog

may be displayed.  Follow the instructions for licensing or click OK to continue. Then the 
main Configuration Manager window displays.

6.  Start the following services:
HP Internet Services
Reporter Service
World Wide Web Publishing Service
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 Setup Oracle as the Database

Part H: Configure Oracle 9i as the Database

Set Up Oracle 9i on HP-UX or Solaris and Configure on Windows

 IMPORTANT: If HP OpenView Internet Services and hp OpenView Reporter are installed on the same system, 
migration of your OVIS/Reporter data from your existing database to Oracle 9i is not supported.

Prerequisites: Because a successful Oracle configuration is dependent upon correct kernel parameter settings, 
check your HP-UX or Solaris system kernel parameters (see the Oracle 9i Release Notes for these parameters). 
Ensure you have the following available:

●     Memory: 512 MB RAM minimum
●     Swap space: disk space equivalent to the greater of 2*RAM, or at least 512 MB
●     CD-ROM: capable of reading ISO 9660 format with RockRidge extensions
●     Disk space: 2.5 GB for database software; 1 GB for database
●     Temp disk space: 400MB in /tmp directory
●     HP-UX 11.0 (64-bit) or or HP-UX 11i (64-bit)

or
Solaris 7 (5.7) or 8 (5.8), 9 (5.9)

●     Operating system patches (detail in the Oracle9i Release Notes)
●     JAVA components (detailed in the Oracle9i Release Notes)
●     HP-UX note: an important pre-installation step is required relating to X library symbolic links

Oracle Documentation: The documents can be found on the Oracle9i Database CD-ROMs. To access them, 
mount Disk 1 of the Oracle9i Database CD-ROM and open the index.html. Oracle also provides online resources for 
documentation at the Oracle Documentation Center (docs.oracle.com) and the Oracle Technology Network 
(otn.oracle.com/docs/).For Oracle-specific information, please check the following:

●     Oracle9i Installation Guide
●     Oracle9i Quick Installation Procedure
●     Oracle9i Release Notes

Configuration steps are divided into two sets of tasks as follows:

Server setup for Oracle9i on HP-UX or Solaris system:

●     Prepare the UNIX environment
●     Mount the installation CD
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●     Install Oracle9i Database Server software
●     Configure a database listener
●     Create the Reporter database structure
●     Create the Reporter database user and privileges

Client setup for Oracle9i on Windows OVIS system:

●     Install Oacle9i client software
●     Configure the Oracle Net connection
●     Verify the Oracle Net connection
●     Configure the ODBC data source
●     Configure the database in OVIS

Server Set Up for Oracle 9i on HP-UX or Solaris
Task 1  Prepare the UNIX Environment

1.  Create the Oracle UNIX groups:
HP-UX: use the System Administrator's Manager (SAM) to create groups
Solaris: use the admintool or groupadd utility to create groups

i. Log in as the root user.
ii. Create UNIX group "dba" (The OSDBA group)
iii. Create UNIX group "oper" (The OSOPER group)
iv. Create UNIX group "oinstall" (The ORAINVENTORY group)
HP-UX note: See the Oracle9i Quick Installation Procedure for the special privileges that should be 
assigned to the OSDBA group.

2.  Create the UNIX user "oracle":
HP-UX: use the System Administrator's Manager (SAM) to create accounts
Solaris: use the admintool or useradd utility to create accounts.

Create UNIX user "oracle" (This account is for Oracle software installation and upgrading only)
   — Primary group: oinstall (The ORAINVENTORY group)
   — Secondary group: dba (The OSDBA group)
Create UNIX user "apache"
   — Primary group: oinstall (The ORAINVENTORY group)
   — Secondary group: group in which apache is only member.
       The Apache account should have minimum privileges.

3.  Create mount points for Oracle database software
i. Create Oracle Home mount point:
    mkdir -p /opt/oracle/product/9.0.1
ii. Enter: cd /opt
iii. Enter: chown -R oracle:oinstall oracle

iv. Make sure a local bin directory such as /usr/local/bin or /opt/bin exists.

v. Set UNIX system and Oracle environment variables
   (add to .profile or set manually)
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   DISPLAY=<workstation_name>:0.0 (where output from Oracle installer displays)
   ORACLE_BASE=/opt/oracle
   ORACLE_HOME=/opt/oracle/product/9.0.1
   ORACLE_SID=reporter
   PATH includes $ORACLE_HOME/bin, /usr/ccs/bin, /usr/bin, /etc, (/usr/bin/X11
   for HP-UX), (/usr/openwin/bin for Solaris), and /usr/local/bin (if it exists)

Example of .profile for HP-UX:

   # Oracle Environment
   ORACLE_BASE=/opt/oracle; export ORACLE_BASE
   ORACLE_HOME=/opt/oracle/product/9.0.1; export ORACLE_HOME
   ORACLE_SID=reporter; export ORACLE_SID
   ORACLE_TERM=xterm; export ORACLE_TERM
   TNS_ADMIN=/export/home/oracle/config/9.0.1; export TNS_ADMIN
   NLS_LANG=AMERICAN_AMERICA.UTF8; export NLS_LANG
   ORA_NLS33=$ORACLE_HOME/ocommon/nls/admin/data; export ORA_NLS33
   LD_LIBRARY_PATH=$ORACLE_HOME/lib:/lib:/usr/lib:$ORACLE_HOME/rdbms/lib
   SHLIB_PATH=$ORACLE_HOME/lib32:$ORACLE_HOME/rdbms/lib32
   export LD_LIBRARY_PATH
   export SHLIB_PATH

   #set shell search paths
   PATH=/bin:/usr/bin:/usr/sbin:/etc:/opt/bin:/usr/ccs/bin:/usr/local/bin:$ORACLE_HOME/bin
   export PATH

   #CLASSPATH must include the following JRE locations:
   CLASSPATH=$ORACLE_HOME/JRE:$ORACLE_HOME/jlib:$ORACLE_HOME/rdbms/jlib
   CLASSPATH=$CLASSPATH:$ORACLE_HOME/network/jlib

Task 2  Mount the Installation CD

    For HP-UX:

1.  Edit the /etc/pfs_fstab file to add the following:

<device_file> <mount_point> <filesystem_type> <translation_method>

Definitions of the above syntax:

●     <device_file> = CD-ROM device file (discover with ioscan -nFC disk)
●     <mount_point> = path name of the mount point
●     <filesystem_type> = CD-ROM is in IS09660 format, Rockridge extension
●      <translation_method> = unix

For example:
/dev/dsk/c1t2d0 /CDROM pfs-rrip xlat=unix 0 0

2.  Perform the following steps as the root user:

Enter: /usr/sbin/pfs_mountd & (Note:pfs creates the correct format to read the CD)
Enter: /usr/sbin/pfsd & 
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3.  Insert the CD into the CD-ROM and mount the device as follows:
/usr/sbin/pfs_mount /CDROM

4.  Change directories to /CDROM where you can see a lower-case listing of the directories and files on the CD-
ROM.
(The mounted CD should appear as another read-only file system.)

Leave the root user window available for executing a script during installation .

For Solaris:
If you are using Volume Management software (available by default on Solaris) the CD-ROM is mounted 
automatically to /cdrom/orcl901_1 when you put it into the disk drive.
If you are not using the Volume Management software, you must mount the CD-ROM manually.

1.  Place the Oracle 9i CD-ROM in the CD-ROM drive.
2.  Log in as the root or su user and create a CD-ROM mount point directory:

$ su root
# mkdir cdrom_mount_point_directory

3.  Mount the CD-ROM drive on the mount point directory and exit:
# mount option device_name cdrom_mount_point_directory
# exit

Task 3  Install Oracle 9i Database Server Software

1.  Log in to the Oracle account.
2.  Launch the Oracle Universal Installer by typing the full path to the installer executable.

Example:
 /cdrom/oracle9i/runInstaller or /CDROM/runInstaller.

3.  For first-time Oracle9i installations the Welcome window appears, where you click Next.
4.  In the Inventory Location window specify a base directory and click OK.
5.  In the UNIX Group Name window enter oinstall (the ORAINVENTORY Group) and click Next.
6.  You may have to run a script if pre-installation tasks were not completed.
7.  In the File Locations window do not change the text in the source field and click Next.
8.  In the Available Products window select Oracle9i Database and click Next.
9.  In the Installation Types window select Enterprise Edition.

(Alternatively you can select the Standard Edition; see Oracle documentation for differences between these 
installation types.) Click Next.

10.  In the Database Configuration Window select Software Only and click Next.
11.  In the Choose JDK Home Directory enter the appropriate location and click Next.
12.  Review the Summary Window and click Install.

(When the Install window appears, wait as the products is installed.)
13.  When the Setup Privileges window appears, run the script as instructed.
14.  In the End of Installation window select Exit.

Task 4  Configure a database listener

1.  At a UNIX console window, logged in as the Oracle user, enter netca to start the Oracle Net Configuration 
Assistant. 

2.  In the Welcome window select Listener configuration and click Next. 
3.  Select Add and click Next. 
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4.  Enter a listener name (LISTENER is suggested) and click Next. 
5.  For the connection protocol select TCP and click Next. 
6.  Select the standard port number 1521 and click Next. 
7.  For configuring another listener, select No. 
8.  At the configuration complete message click Next. 
9.  In the final window click Finish.

Task 5  Create the Reporter database structure

1.  At a UNIX console window, logged in as the Oracle user, enter dbca to Start the Oracle Database 
Configuration Assistant.

2.  Select the Create a Database option and click Next.

 Important: These procedures and screen examples are for Oracle 9.0.1 on HP-UX.  
Other operating systems and versions may be different.
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3.  Select the New Database template and click Next.

4.  Supply Global Database Name and the SID and click Next.
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5.  You can optionally de-select the  listed features, which are not required for the Reporter database, and click 
Next.

6.  Select the Dedicated Server Mode click Next.

7.  For Memory Parameters, the user concurrency may be as high as 40, depending upon the options selected 
in OVIS; use 200 - 300 MB of RAM (or as directed by your DBA) and click Next.
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

8.  (optional) Select the Archive tab and the Archive Log Mode if you want a back up strategy that ensures data 
recoverability that goes beyond the most recent backup.
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

9.  Click Next.
10.  Select the DB Sizing tab and set the Block Size to 8K.
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

11.  Select the File Locations tab, where you can review the location settings, and click Next.
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

12.  In the Database Storage window click the Tablespaces entry in the tree to view current tablespace 
configuration.
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

13.  Click the Add button to add the REPORTER tablespace. Size the tablespace to 600MB. 

 Important: If the actual storage size of 600MB for REPORTER tablespace and 300MB for the 
RPT_INDEXES tablespace is not large enough, please consult your Oracle DBA on the appropriate
size for your environment or how to setup the AUTOEXTEND datafile feature in Oracle.
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

14.  Select the Storage tab, verify Locally Managed extents with Automatic Allocation, and click Create.
15.  Click the Add button to add the RPT_INDEXES tablespace, size the tablespace to 300MB.
16.  Select the Storage tab, verify Locally Managed extents with Automatic Allocation, and click Create.
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

17.  Click the Tablespaces entry in the tree to verify that the REPORTER and RPT_INDEXES tablespaces have 
been added to the configuration, and click Next.

18.  Select the Create Database option. (Optionally, you can save scripts for this DB creation process and 
execute them later.) Click Finish.

19.  When the Database Creation progress window appears, several hours may be required to create the 
database depending upon the options that are selected. Respond to the database creation completion 
messages and close the Database Configuration Assistant.
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

20.  (Optional) Verify the availability of the REPORTER database.
A. At a UNIX console window, log in as the Oracle user, and start the SQL *Plus environment by
    entering: sqlplus
B. Supply the user-name and password (for example, system / manager should be available as a user-
name and password on this newly created database).
C. At the SQL prompt enter column tablespace_name format a40;.
D. Enter select tablepspace_name, status from user_tablespaces;
E. Verify that the expected tablespaces are available and enter exit to leave SQL *Plus.
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

Task 6 Create the Reporter database user and privileges

1. Start the SQL *Plus environment as described above.

2. Execute the following SQL statements to create the user for the REPORTER database:

create user openview profile default
identified by openview
default tablespace reporter
temporary tablespace temp
quota unlimited on reporter
quota unlimited on rpt_indexes
account unlock;
grant
create any index,
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

create procedure,
create sequence,
create session,
create table,
create trigger,
create view,
connect to openview;

Configure Oracle Client Software on the Windows 
System
This section covers the installation of the software that allows the Windows system, on which OVIS runs, to connect 
to the HP-UX or Solaris system, from which the Oracle database is accessed.

Task 1  Install Oracle 9i Client software

1.  At the Windows NT/2000 system that hosts OVIS, insert the Oracle9i installation CD and in the window that 
appears select Install/Deinstall Products .

2.  In the Oracle Universal Installer Welcome window click Next.
3.  Enter or select an Oracle 9 home location for this installation and click Next.
4.  In the Available Products window select Oracle9i Client and click Next.
5.  In the Installation Types window select Administrator and click Next.
6.  Verify the information in the Summary window and click Install.

A window showing installation progress will appear. The installation process also starts the Oracle Net Configuration 
Assistant tool. Proceed to Task 2 for completion of this activity.

Task 2 Configure the Oracle Net connection

The Oracle Net Configuration Assistant tool can be started independently (without re-installing client software) by 
selecting Start -> Programs -> Oracle-OraHome9 -> Configuration and Migration Tools -> Net Configuration 
Assistant. The first few dialogs differ between an installation-initiated Assistant compared with an independently 
started Assistant. The steps below use the dialogs encountered when the Assistant is started as part of the client 
installation.

1.  In the Welcome window select No, I will create net service names myself., and click Next.
2.  In the Database Version window select Oracle8i or later and click Next.
3.  In the Service Name window supply the service name for the database (typically reporter or 

reporter.<domain>, the global database name), and click Next.
4.  In the Select Protocols window choose the appropriate network protocol (typically TCP), and click Next.
5.  In the TCP/IP Protocol window, supply the Host name and port number (typically 1521), click Next.
6.  In the Test window, select Yes, and click Next.
7.  In the Connecting window verify that the connection was successful; you may have to change the login 

credentials (openview/openview) for the test to succeed.
8.  Click Next.
9.  In the Net Service Name window supply a service name (suggested: RPT), and click Next.

10.  In the Another Net Service Name window select No, and click Next.
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

11.  In the Done window click Next and then Finish.

Task 3 Verify the Oracle Net connection

After completion of the Oracle Net Configuration, perform the following steps to verify that you can connect to the 
Reporter database from your Windows system.

1.  Start the SQL *Plus tool by selecting Start -> Programs -> Oracle-OraHome9 -> Application 
Development -> SQL Plus.

2.  At the Log On dialog supply the User Name (system), Password (manager), and Host String (RPT), [the Net 
Service Name supplied in Task 2, step 9].

3.  Enter the following SQL statement: select tablespace_name, status from user_tablespaces;

You should see results similar to the following:

If you cannot connect to the database, or do not see these tablespaces, check with the Oracle database 
administrator for the UNIX host system.

4.  To leave the SQL *Plus environment, type Exit. 
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

Task 4  Configure the ODBC data source

1.  To launch the Windows Control Panel, select Start -> Settings -> Control Panel.
2.  For Windows 2000, double-click Administrative Tools, then double-click Data Sources (ODBC).

For Windows NT4, double-click ODBC Data Sources.
3.  In the ODBC Data Source Administrator, select the System DSN tab.
4.  If it exists, select the Reporter DSN and remove it.
5.  Select the Add… button and highlight the Oracle in OraHome9 driver and click Finish.
6.  In the Oracle ODBC Driver Configuration window enter Reporter as the Data Source name.

 Important: You must enter Reporter as the Data Source Name in mixed case (uppercase "R") to 
match references to it in Internet Services executables.

For the TNS Service Name, from the drop-down menu select the name configured in
Task 2, step 9 (RPT).

Select the Oracle tab and set Prefetch Count to 25 and disable LOBs.

 

7.  To test the connection (if desired), click Test Connection and supply the username and password 
(openview/openview).

8.  To add this data source to the System DSNs, click OK.
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Part H: Configure Oracle 9i (HP-UX or Solaris) as the Database

Task 5  Configure the Database in OVIS

1.  To start  Internet Services Configuration Manager, select 
Start>Programs>HP OpenView>internet services>Configuration Manager.

2.  An error message is expected; click Yes or OK to proceed.  Then database login may be required, if
so see the next step, proceed to step 5. 

3.  In the Database Login dialog box, enter the database User Name and Password that you used for the 
UNIX system configuration in Task 6 (username: openview; password: openview).

 
4.  Click OK 
5.  You will see the  Internet Services Startup status bars. Then the Configure License dialog

may be displayed.  Follow the instructions for licensing or click OK to continue. Then the 
main Configuration Manager window displays.

6.  Start the following services:
HP Internet Services
Reporter Service
World Wide Web Publishing Service
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Legal Notices

  Legal Notices 

 

Hewlett-Packard makes no warranty of any kind with regard to the material in this web site, including but 
not limited to, the implied warranties of merchantability and fitness for a particular purpose. Hewlett-
Packard shall not be held liable for errors contained herein or direct, indirect, special, incidental, or 
consequential damages in connection with the furnishing performance, or use of this material.

Warranty. A copy of the specific warranty terms applicable to your Hewlett-Packard product and 
replacement parts can be obtained from your local Sales and Service Office. 

Restricted Rights Legend . All rights are reserved. No part of this web site may copied, reproduced, or 
translated to another language without the prior written consent of Hewlett-Packard Company. The 
information contained in this web site is subject to change without notice. 

Use, duplication or disclosure by the U.S. Government is subject to restrictions as set forth in 
subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-
7013 for DOD agencies, and subparagraphs (c)(1) and (c)(2) of the Commercial Computer Software 
Restricted Rights clause at FAR 52.227-19 for other agencies. 

HEWLETT-PACKARD COMPANY
8000 Foothills Boulevard
Roseville, CA 95747 United States of America 

Copyright Notices. © Copyright 2003 Hewlett-Packard Company, all rights reserved. 

Reproduction, adaptation, or translation of this web site without prior written permission is prohibited, 
except as allowed under the copyright laws of the United States. 

Trademark Notices. 
Java™ is a trademark of Sun Microsystems, Inc. 
Microsoft® is a U.S. registered trademark of Microsoft Corporation. 
Windows NT® is a U.S. registered trademark of Microsoft Corporation. 
Windows® and MS Windows® are U.S. registered trademarks of Microsoft Corporation. 
Netscape™ and Netscape Navigator™ are U.S. trademarks of Netscape Communications Corporation. 
Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California. 
Oracle7™ is a trademark of Oracle Corporation, Redwood City, California. 
OSF/Motif® and Open Software Foundation® are trademarks of Open Software Foundation in the U.S. 
and other countries. 
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Pentium® is a U.S. registered trademark of Intel Corporation. 
UNIX® is a registered trademark of The Open Group.
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